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�����1 About this guide

This guide is intended for operators of the Codan 8800 series 
Digital Microwave Radio who intend to use MINet regularly 
to:

� supervise and perform link monitoring

� configure and manage tasks

� issue reports

� follow up link events displayed on the PC

It assumes that you have a good knowledge of a Windows-
based environment.

The following sections are included:

Section 1 About this guide�explains the terms and 
abbreviations used in this guide

Section 2 Overview�provides an introduction to MINet 
and shows how MINet interacts with Codan 
8800 series DMR equipment

Section 3 Installation�lists system requirements, 
explains software installation, and shows how to 
verify that the correct software version is 
installed

Section 4 The MINet window�describes the MINet 
window for a 1+0 and a 1+1 configuration, and 
general functionality of MINet

Section 5 Setting up a link�describes how to set up a link

Section 6 Operating MINet�describes how to work with 
configuration files, access status and 
performance information, change passwords, 
upgrade firmware, switch memory banks, and 
reset terminals

Appendix A Example network diagrams�provides diagrams 
and example IP addresses for out-of-band and 
in-band management

There is an index at the end of this guide.



About this guide

2  MINet Management Software User Guide

Standards and icons
The following standards and icons are used in this guide:

This typeface... Means...

Italic a cross-reference or text requiring emphasis

Bold the name of a button, knob, LED, and a 
segment of text from the display

Bold text that is typed in as a command, or the 
name of a key on a computer keyboard

This syntax... Means...

<variable> the text within the brackets may vary 
depending on the context

This icon... Means...

1 a step within a task

NOTE the text provided next to this icon may be of 
interest to you

CAUTION proceed with caution as your actions may 
lead to loss of data, privacy or signal quality

WARNING your actions may cause harm to yourself or 
the equipment
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Definitions

Acronyms and abbreviations

This term Means...

AIS alarm indication signal

BBER background block error rate

BER bit error rate

BLER block error rate

DIU data interface unit

DMR digital microwave radio

ES errored seconds

ESR errored-second ratio

ETSI European Telecommunications Standards 
Institute

FCC Federal Communications Commission

FCS frame check sequence

GUI graphical user interface

IDU indoor unit

IF intermediate frequency

LAN local area network

LED light-emitting diode

LOS loss of signal (in tributary)

MIB management information base

MINet microwave intelligent network
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NMS network management system

ODU outdoor unit

OSI open source interconnect

PDH plesiochronous digital hierarchy 

ppm parts per million

RSL received signal level

Rx receive

SES severely-errored second

SLIP Serial Link Internet Protocol

SNMP Simple Network Management Protocol

SQE signal quality event

TCP/IP Transmission Control Protocol/Internet 
Protocol

TFTP Trivial File Transfer Protocol

TTL time to live

Tx transmit

UAS unavailable seconds

UPS uninterruptible power supply

NCBLER not corrected block error rate

This term Means...
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Glossary

This term... Means...

active link The link in a 1+1 redundancy system that is 
currently transmitting data.

alternate link The link in a 1+1 redundancy system that is 
not currently active in the MINet window.

background 
block error rate
(BBER)

The number of block errors occurring in a 
one-second period that did not occur as part 
of an SES.

block size A block is 2040 bits. This is used in 
performance calculations.

corrected block 
error rate

The number of errored blocks per second 
that are corrected by the internal FEC of the 
DMR. These corrected errors do not affect 
customer traffic.

errored block A block (2040 bits) that contains at least 
one errored bit.

errored second The number of one-second periods with one 
or more errored blocks. Each second 
contains 16 blocks.

left terminal The terminal displayed on the left side of 
the MINet window.

management 
information base 
(MIB)

A directory listing of the logical names of 
all information resources residing in a 
network and relevant to the network�s 
management.

mute The removal of Tx power.

not corrected 
block error rate

The number of errored blocks per second 
that are not corrected by the internal FEC of 
the DMR. These errors affect customer 
traffic.
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Units

peer channel The channel used for remote radio 
communications, network management and 
auxiliary traffic.

right terminal The terminal displayed on the right side of 
the MINet window.

severely-errored 
second
(SES)

A one-second period with at least five 
errored blocks (30% error threshold).

Simple Network 
Management 
Protocol
(SNMP)

The most common method by which 
network management applications query a 
management agent using a support MIB. 
SNMP operates at the OSI application layer.

total secs The sample size in seconds.

unavailable secs
(UAS)

The unavailable time due to consecutive 
severely-errored seconds. The UAS starts 
accumulating at the start of 10 consecutive 
SES (included as unavailable time), and 
stops with 10 consecutive non-SES 
(included as available time).

Measurement Unit Abbreviation

Frequency hertz Hz

Power decibels relative to 
1 mW

dBm

Power watt W

Temperature degrees Celsius °C

This term... Means...
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Unit multipliers

NOTE

Units are expressed in accordance with ISO 
1000:1992 �SI units and recommendations for 
the use of their multiples and of certain other 
units�.

Unit Name Multiplier

d deci 0.1

k kilo 1000

M mega 1000000

G giga 1000000000
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About this issue
This is the second issue of the MINet Management Software 
User Guide. This issue includes information on using MINet 
with 1+1 redundancy systems.

Associated documents

The associated documents are:

� Digital Microwave Radio 8800 series Quick Install 
Handbook (Codan part number 15-44024-EN)

� Digital Microwave Radio 8800 series Reference Manual 
(Codan part number 15-44025-EN)

� Digital Microwave Radio 8800 series Redundancy 
Systems Reference Manual (Codan part number 
15-44029-EN)



MINet Management Software User Guide 9

�����2 Overview

This section contains the following topics:

Introduction to MINet (10)

System access (12)

Configurations (13)
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Introduction to MINet
MINet is a PC-based element manager that controls and 
monitors the status of Codan 8800 series DMR links, either 
individually or within a network. MINet uses a GUI-based 
Windows environment and SNMP to communicate with and 
manage links that have management platforms based on 
TCP/IP.

MINet enables operators to perform the following activities 
within a Codan 8800 series DMR system:

� set any terminal�s properties

� set alarm thresholds

� set security across the network

� perform tests

� view all data port information

� monitor and analyse traffic and system events

� report link events

� perform firmware upgrades to local, remote and network 
terminals

� log the performance of the terminal

A link or microwave network can be managed with either 
in-band or out-of-band management, depending on the DIU 
plugged into the IDU.

NOTE

MINet automatically detects whether the 
terminal to which it is connecting is in a 1+0 or 
1+1 system. The corresponding graphics in the 
MINet window are displayed (see page 21, The 
MINet window).
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Out-of-band management is performed via the link using a 
64 KB bandwidth segment, known as a peer channel. Out-of-
band management is essential with PDH DIUs, and may also 
be used with Eth 10/100 DIUs if required. An IP address must 
be assigned to the ETH port on the front of the IDU. For more 
information on out-of-band management see the Digital 
Microwave Radio 8800 series Reference Manual or Digital 
Microwave Radio 8800 series Redundancy Systems Reference 
Manual and page 31, Out-of-band management.

In-band management is available with an Eth 10/100 DIU. 
The link management is performed in a dynamic manner 
within the customer�s bandwidth range. The bandwidth 
available for link management expands and contracts 
depending on the volume of management traffic required. An 
IP address must be assigned to the Eth 10/100 port on the DIU. 
For more information on in-band management see the Digital 
Microwave Radio 8800 series Reference Manual or Digital 
Microwave Radio 8800 series Redundancy Systems Reference 
Manual and page 32, In-band management.

Each IDU in a Codan 8800 series DMR contains an SNMP 
agent. MINet and the agent communicate using SNMP over 
TCP/IP. The SNMP agent contains a database of standard and 
private SNMP MIBs.

To acquire information, MINet communicates with the agent 
in the IDU. MINet generally functions as a master and the 
agent as a slave. An exception to this master-slave relationship 
is the handling of important alarm conditions, known as traps, 
which may be defined by the operator of the 8800 series 
DMR. Traps are initiated by the agent, then sent to MINet.

You can have multiple sessions of MINet open at a time, each 
with its own active configuration, however, only a single link 
can be active and polled at one time from a single PC. If an 
SNMP manager, such as HP OpenView, is used, multiple 
sessions can be initiated. A full network management system 
uses this multiple-session capability with traps and trap 
managers.



Overview

12  MINet Management Software User Guide

System access
MINet provides three levels of system access:

� user, for accessing terminals and viewing parameters

� administrator, for modifying parameters that do not 
affect traffic

� supervisor, for modifying any configurations in the DMR 
and upgrading firmware (full access)

System security is automatically activated when there is any 
attempt to modify system parameters or access a particular 
function when the operator does not have authorisation to do 
so. A further level of protection is the SNMP community 
name, which determines an operator�s read/write 
authorisation.
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Configurations
Each radio terminal contains factory-default settings that are 
stored in the firmware of the radio. When a new terminal is 
initially powered up, the factory settings are loaded as the 
active configuration of the radio. For more information on 
factory-default settings see the Digital Microwave Radio 8800 
series Reference Manual or Digital Microwave Radio 8800 
series Redundancy Systems Reference Manual. When a link is 
initially accessed using MINet, the radio configuration can be 
modified and this new configuration made active using 
MINet. Factory-default settings may be restored, if required, 
at any time using the front panel of the IDU, or MINet.

Each IDU stores an active configuration in a dedicated non-
volatile memory. This configuration is used by the IDU when 
it is necessary to restart the terminal.

MINet operates directly with terminals in On-line mode, 
allowing the active configuration to be changed while the 
system is operational. On-line mode may also be used for 
maintenance and commissioning the system. The active 
configuration may be saved to a file as a backup configuration.

MINet may also be operated in Off-line mode. You can open 
saved backup files, and edit and save configurations to a file.
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�����3 Installation

This section contains the following topics:

System requirements (16)

Installing MINet (17)

Accessing MINet (18)

Uninstalling MINet (20)



Installation

16  MINet Management Software User Guide

System requirements

Required hardware

The following minimum hardware must be available:

� Pentium 3 processor

� 100 MB of free disk space

� 256 MB of memory

Required software

The following software must be installed:

� Microsoft Windows 98, 2000, NT 4.0, or XP with latest 
service packs
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Installing MINet
Before installing MINet, it is strongly recommended that all 
other applications are closed.

If upgrading from a previous version of MINet, manually 
remove the earlier one using Add or Remove Programs 
(via Start�Control Panel).

To install MINet:

1 Exit any active HP OpenView and/or MINet sessions.

1 Place the MINet CD into the CD drive on your PC.

A MINet splashscreen appears.

1 Click on Install MINet.

1 Follow the prompts in the Installation Wizard.

When the installation is complete, a Codan logo, titled 
MINet <X.XX>, appears on the desktop.
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Accessing MINet

Accessing MINet

To access MINet:

1 Double-click on the MINet icon on the desktop.

The Authorisation dialog is displayed.

Authorisation is required to access links, and to read and 
modify terminal parameters. You can log into:

� user level, to access terminals and view parameters

� administrator level, to modifying parameters that do 
not affect traffic

� supervisor level, to modify any configurations in the 
DMR and upgrade firmware (full access)

Figure 1: Authorisation dialog

1 Select the access level that you want to enter, then enter 
the factory-default password corresponding to the access 
level.
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1 Click Supervisor, type super as the password, then 
click OK.

The Load Active Configuration dialog is displayed.

Verifying correct installation

To verify correct installation:

1 Click Cancel to work off line.

1 From the Help menu, select About to verify that the 
correct version of MINet is installed.

1 From the File menu, select Exit to close MINet.

Security level Factory-default password

User user

Administrator admin

Supervisor super

NOTE The password is case-sensitive.

CAUTION

You should change these passwords as 
soon as possible after MINet is installed. 
For more information see page 113, 
Restricting access to the configuration of 
the 8800 series DMR.
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Uninstalling MINet

To uninstall MINet:

1 In Microsoft Windows, from the Start menu, select 
Control Panel�Add or Remove Programs.

1 Remove MINet.

NOTE

Your actions from this point depend upon 
the version of Microsoft Windows that you 
have installed. For more information on 
this topic refer to the on-line help provided 
for Windows.
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�����4 The MINet window

Figure 2: The MINet window for a 1+0 link

NOTE

MINet automatically detects whether the 
terminal to which it is connecting is in a 1+0 or 
1+1 system. The corresponding graphics in the 
MINet window are displayed.
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Figure 3: The MINet window for a 1+1 link

The MINet window shows a link with equipment at the left 
end and equipment at the right end. The left and right 
conventions used in this guide designate terminals that have 
their parameters displayed in either the left or right panel of 
the MINet window. The left or right position of a terminal in 
the MINet window does not affect configuration, 
management, or monitoring functionality.

In a 1+0 system, there is a terminal (IDU, ODU and antenna) 
at each end of the link (see Figure 2 on page 21). In a 1+1 
redundancy system, there are two terminals at each end of the 
link, and either an access panel or Y-cable connecting the two 
IDUs (see Figure 3 on page 22).
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There is a graphic representation of the status of the link 
between two terminals. This relates to information displayed 
in the status bar at the bottom of the window. For example, 
when the link is active and good (that is, data is passing 
between the terminals), the representation of the signal 
between these terminals is green. When the link is not active, 
the representation of the signal between the terminals is grey. 
When the link is down, the representation of the signal 
between the terminals is red.

In a 1+0 system, the key operational parameters of each 
terminal are displayed in the boxes immediately below the 
IDU (see Figure 2 on page 21). For E1/E3 and DS1/DS3 
DIUs, these parameters are Tx Power, RSL, and BER. For 
Eth 10/100 DIUs, Util Tx and Util Rx are also displayed. For 
more information on these parameters see page 93, Viewing 
the key operational parameters of a 1+0 link.

Selecting the end of a link
You can select or deselect the end of a link by clicking on the 
link-end selection button on each terminal (pink for the left 
end, blue for the right end). When the end of a link is selected, 
the graphic representation of the terminal is grey. When the 
end of a link is not selected, the graphic representation of the 
terminal is pale pink.

NOTE

1+1 hot standby and 1+1 space diversity 
systems are represented by the same 
redundancy graphic, that is, two antennas at 
each end of the link.
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Selecting a terminal in a 1+1 redundancy system
In a 1+1 redundancy system, you can select the terminal with 
which MINet is communicating by clicking on the terminal 
selection button on either terminal (see Figure 3 on page 22). 
The graphic representation of the selected terminal is grey. 
When a terminal is not selected, its graphic representation is 
pale pink. Only one of the two terminals at the end of a link 
may be selected at a time.

Changing parameters for a terminal
When a terminal is selected, you can use options in the menu 
bar to set up and monitor the parameters for the terminal. 
Figure 4 shows a typical dialog in which you can change or 
monitor parameters.

Figure 4: Example dialog

If you want to keep a dialog open while you open other 
dialogs for the terminal, click the Freeze button ( ) in the 
dialog.

read-only parameter

configurable parameter

Freeze/Release button
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If you shift the dialogs around, then want to arrange the 
dialogs back to the original layout, from the Window menu, 
select Cascade.

Some parameters are derived from the hardware and are read-
only, as shown by a grey background (see Figure 4 on 
page 24). Parameters that can be modified have a white 
background. Parameters that have been modified appear in 
blue until they are saved to the active configuration.

New parameter values may be selected from a drop list, or text 
may be typed into the field. When you click in the Value field 
of a parameter, a drop arrow may appear on the right of the 
field. Click on this arrow to see the available values from 
which to select. If a drop arrow does not appear, click once 
more in the field; a cursor appears, enabling you to enter text.
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Zooming in
When the end of a link is selected, you can double-click on the 
left side of the image of the IDU to zoom in on the IDU. The 
image reflects the type of DIU used in the IDU, and in a 1+1 
redundancy system, the type of connection between the IDUs. 
The tributary status For some DIUs is indicated by their 
colour:

Figure 5: Front panel of the IDU in a 1+0 system

Figure 6: Front panel of the IDU in a 1+1 system

Colour Meaning

Green Tributary is OK

Yellow Tributary has a non-fatal, warning error 
or is not being used

Orange Tributary is under operator control

Red Tributary has a fatal error
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Double-clicking over the keys and LCD zooms in on the front 
panel of the IDU.

Figure 7: LCD and keys on the IDU

Menu and tool bars
The menu bar provides access to all MINet options. The most 
commonly-used MINet functions are accessed using buttons 
on the tool bar. The graphic on the tool-bar button associated 
with each function is also shown next to the option in its 
menu. Some functions are accessed only through the menu 
bar. These functions do not have any graphic next to the option 
in the menu.

When the mouse pointer is placed over any button in the tool 
bar, the name of the button appears below the button. An 
explanation of the function of the button is provided in the left 
side of the status bar.

You can hide the tool bar by deselecting Toolbar in the View 
menu.



The MINet window

28  MINet Management Software User Guide

Status bar
The status bar shows the current operating mode of MINet, 
and the status of the left and right terminals that are selected. 
After the system is powered on and communication between 
the PC and the 8800 series DMR has been established, 
ONLINE is displayed in the status bar. Active configuration 
parameters may be updated, and status and performance may 
be polled when MINet is on line.

When a parameter is modified during an on-line session, the 
status bar automatically switches from NORMAL to 
CONFIG. When the active configuration is updated, the status 
bar switches from CONFIG to NORMAL.

When the operator works with a configuration file (.cfg) that 
has been previously saved from the terminal during an on-line 
session, FILE is displayed in the status bar. If a file is saved 
when the system is on line, an additional *.cfs file, which 
includes terminal status data, is created for each terminal.

When MINet is off line, configurations can only be saved as a 
.cfg file. To update an active configuration with a 
configuration file, MINet must be on line. 

The access level into which you are logged is shown at the 
right side of the status bar.

Configurations
You can have multiple configurations open in MINet at the 
same time. To see the configurations that you have open, or to 
switch between them, go to the Window menu.
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�����5 Setting up a link

This section contains the following topics:

Introduction (30)

Setting up the management PC and DMRs to communicate 
with each other (31)

Setting the redundancy status of an IDU (1+1 redundancy 
systems only) (42)

Loading the active configuration (44)

Setting up a configuration (46)

Updating the active configuration for a new link (77)

Saving the active configuration to file (79)
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Introduction
This section assumes that a link has been installed according 
to the information provided in the Digital Microwave Radio 
8800 series Quick Install Handbook and the Digital 
Microwave Radio 8800 series Reference Manual or Digital 
Microwave Radio 8800 series Redundancy Systems Reference 
Manual.

Once the terminals have been set up to communicate with a 
PC running MINet, the existing configuration of the link may 
be altered as required.

NOTE

In order to manage the 8800 series DMR using 
MINet software, the IP address of the PC 
running MINet and the connected DMR must 
belong to the same network.

NOTE

In order to manage a remote 8800 series DMR 
using out-of-band management, static routes 
may need to be added to the configuration of the 
DMR (see page 31, Setting up the management 
PC and DMRs to communicate with each 
other).
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Setting up the management PC and DMRs 
to communicate with each other

Before setting up the management PC and DMRs, you should 
plan the network according to the type of management that 
you want to use. On a network diagram, you should assign IP 
addresses to the relevant ports. Examples of such diagrams are 
provided on page 123, Example network diagrams. These 
examples use the following IP address format:

Out-of-band management

Out-of-band management requires the following to be set up:

� the IP address of the management PC (see page 33, 
Setting the IP address of the management PC)

� a static route on the management PC (see page 36, 
Setting up a static route on the management PC (out-of-
band management only))

� the IP address of the ETH port (see page 40, Setting the 
IP address of the ETH port)

IP address 212.180.<network address>.<host address>
or
212.181.<network address>.<host address>

Subnet mask 255.255.255.0

NOTE
The IP address of the management PC 
must use the same network address as the 
ETH port on the connected DMR.

NOTE

The IP address of the ETH port must use a 
different network address for terminals at 
each end of a link. Terminals located at the 
same site may use addresses in the same 
network.
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In-band management

In-band management requires the following to be set up:

� the IP address of the management PC (see page 33, 
Setting the IP address of the management PC)

� the IP address of the Eth 10/100 DIU (see page 38, 
Setting the IP address of the Eth 10/100 DIU (in-band 
management only))

� the IP address of the ETH port (for end-to-end 
connectivity during local maintenance) (see page 40, 
Setting the IP address of the ETH port)

NOTE
The IP address of the management PC 
must use the same network address as each 
Eth 10/100 DIU on the network.

NOTE
The IP address of the ETH port must use a 
different network address from each 
Eth 10/100 DIU on the network.
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Setting the IP address of the management PC
The management PC running MINet must use the same 
network address as each Eth 10/100 DIU on the network for 
in-band management, or the same network address as the ETH 
port of the connected DMR for out-of-band management.

To set the IP address of the local PC:

1 In Windows, from the Start menu, select Control 
Panel�Network Connections.

1 Double click on Local Area Connection.

1 Click Properties.

1 Scroll through the listed components used by this 
connection, select Internet Protocol (TCP/IP), then 
click Properties.

NOTE

The options that you see depend upon the 
version of Microsoft Windows that you have 
installed (Windows XP is shown below). For 
more information on this topic refer to the on-
line help provided for Windows.
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1 Select Use the following IP address.

1 Enter a suitable IP address for the PC that contains the 
same network address but a different host address as the 
respective port of the connected DMR, that is 
xxx.xxx.<network address>.<host address>.

For example, the management PC and DMRs used for 
out-of-band management (ETH port) and in-band 
management (Eth 10/100 DIU) would have the following 
IP addresses (see page 123, Example network diagrams):
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1 Check that the subnet mask for the PC is the same as that 
for the DMR, that is 255.255.255.0.

1 Connect the Ethernet port of the PC to the ETH port 
(out-of-band management) or Eth 10/100 DIU (in-band 
management) of the DMR using a crossover Ethernet 
cable.

Connected device IP address 

PC 212.181.1.10 

DMR Out-of-band (ETH port)

212.181.1.100
212.181.1.200

In-band (Eth 10/100 DIU)

212.181.1.100
212.181.1.110
212.181.1.120
212.181.1.130
212.181.1.140
212.181.1.150
212.181.1.160
212.181.1.170

NOTE

The network diagrams show this 
connection being made via an Ethernet 
connection for both out-of-band and 
in-band management (see page 123, 
Example network diagrams).
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Setting up a static route on the management PC (out-of-
band management only)

In order to manage a terminal or network using out-of-band 
management, a static route is required on the management or 
local PC. This may be set up in two ways:

To add a permanent static route for network connectivity and 
management purposes:

1 In the Command Prompt session, type:

route add <IP address of network> mask <subnet 
mask> <IP address of ETH port on local terminal> �p 

For example, using the network diagram for out-of-band 
management presented on page 123, Example network 
diagrams as a guide:

route add 212.180.0.0 mask 255.255.0.0 
212.181.1.100 �p 

This sets up a static route on the PC for all terminals 
connected to the network.

Using the... Purpose

route add 
command at the 
Command Prompt 
on the 
management PC

Used for network connectivity and 
management of a number of terminals, 
and requires the NMS-IN and 
NMS-OUT ports on IDUs at the same 
site to be daisy-chained together using 
a standard ethernet cable.

Find Agent IP 
button in MINet 
on a local PC

Used for local fault finding or 
maintenance activities.

NOTE

The IP address of the ETH port on IDUs at 
the same site must use the same network 
address. Each site in the network must use 
a different network address.
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1 Ping each terminal on the network to check connectivity.

ping <IP address of terminal>

This command pings the specific terminal on the 
network. A reply should be received from the DMR.

The computer is now configured to communicate to all 
terminals in the network.

1 Close the Command Prompt session.

To add a temporary static route to a local PC for fault finding 
purposes:

1 Access MINet at Supervisor level (see page 18, 
Accessing MINet).

1 Enter the IP address for one terminal, enter codan in the 
Community frames, then click Find Agent IP for the 
other terminal.

The terminal communicates with the terminal at the other 
end of the link and requests its IP address.

A message is displayed that asks if you would like to add 
the IP address of the other terminal to the routing table of 
the PC.

1 Click Yes to add the temporary route to the routing table 
of the local PC.
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Setting the IP address of the Eth 10/100 DIU (in-band 
management only)

The IP address of the Eth 10/100 DIU is set using the keys on 
the front panel of the IDU. For more information on using 
these keys see the Digital Microwave Radio 8800 series 
Reference Manual or Digital Microwave Radio 8800 series 
Redundancy Systems Reference Manual.

To set the IP address of the Eth 10/100 DIU:

1 Press SEL/SAVE to enter the menu options.

1 Scroll through the menu options using ! or " until 
CONFIGURATION is displayed.

1 Press SEL/SAVE to enter the CONFIGURATION 
menu.

A password prompt is displayed. 

1 Enter the supervisor password:

ESC ESC """.

1 Use ! or " to move through the CONFIGURATION 
menu until IP MANAGEMENT is displayed.

1 Press SEL/SAVE to enter the IP MANAGEMENT 
menu.
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1 Use ! or " to move through the IP MANAGEMENT 
menu until ETH 10/100 IP is displayed.

1 Set the IP address to an appropriate address as assigned 
by a network administrator.

For example, using the network diagram for in-band 
management presented on page 123, Example network 
diagrams as a guide, an appropriate address would be:

212.181.<network address>.<host address>, or
212.181.1.110

1 Use ! or " to move through the IP MANAGEMENT 
menu until ETH 10/100 IPmask is displayed.

1 Set the Eth 10/100 IPmask address to the required value.

1 Repeat the above steps on the front panel of the other 
terminals in the network.

NOTE You need to use the same subnet mask for 
the PC running MINet.

����������������
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Setting the IP address of the ETH port
The IP address of the ETH port is set using the keys on the 
front panel of the IDU. For more information on using these 
keys see the Digital Microwave Radio 8800 series Reference 
Manual or Digital Microwave Radio 8800 series Redundancy 
Systems Reference Manual.

To set the IP address of the ETH port:

1 Press SEL/SAVE to enter the menu options.

1 Scroll through the menu options using ! or " until 
CONFIGURATION is displayed.

1 Press SEL/SAVE to enter the CONFIGURATION 
menu.

A password prompt is displayed. 

1 Enter the supervisor password:

ESC ESC """.

1 Use ! or " to move through the CONFIGURATION 
menu until IP MANAGEMENT is displayed.

1 Press SEL/SAVE to enter the IP MANAGEMENT 
menu.
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1 Use ! or " to move through the IP MANAGEMENT 
menu until ETH IP is displayed.

1 Set the IP address to an appropriate address as assigned 
by a network administrator.

For example, using the network diagrams presented on 
page 123, Example network diagrams as a guide, an 
appropriate address would be:

212.180.<network address>.<host address>, or
212.181.<network address>.<host address>
212.181.1.100 (out-of-band management)
212.180.6.100 (in-band management)

1 Use ! or " to move through the IP MANAGEMENT 
menu until ETH IpMask is displayed.

1 Set the address from the ETH IpMask option as the 
subnet mask.

1 Repeat the above steps on the front panel of the other 
terminal to set its IP address and subnet mask.

NOTE

The IP address of the ETH port on IDUs at 
the same site must use the same network 
address. Each site in the network must use 
a different network address.

NOTE

For in-band management, the IP address of 
the ETH port must use a different network 
address from the IP address of the 
Eth 10/100 DIU.

NOTE You need to use the same subnet mask for 
the PC running MINet.
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Setting the redundancy status of an IDU 
(1+1 redundancy systems only)

If you are setting up a 1+1 redundancy system, you must 
designate each IDU at one end of the link as either the primary 
or secondary unit. The redundancy status is set using the keys 
on the front panel of the IDU. For more information on using 
these keys see the Digital Microwave Radio 8800 series 
Reference Manual or Digital Microwave Radio 8800 series 
Redundancy Systems Reference Manual.

To set the redundancy status of the IDU:

1 Press SEL/SAVE to enter the menu options.

1 Scroll through the menu options using ! or " until 
CONFIGURATION is displayed.

1 Press SEL/SAVE to enter the CONFIGURATION 
menu.

A password prompt is displayed. 

1 Enter the supervisor password:

ESC ESC """.
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1 Use ! or " to move through the CONFIGURATION 
menu until OPERATIONS is displayed.

1 Press SEL/SAVE to enter the OPERATIONS menu, 
then use ! or " to move through the menu until 
1+1 CONFIG is displayed.

1 On the main IDU (upper), use ! or " to scroll to 
PRIMARY.

1 On the standby IDU (lower), use ! or " to scroll to 
SECONDARY.

1 Press SEL/SAVE to save the status on both IDUs.
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Loading the active configuration
To load the active configuration:

1 Access MINet at Supervisor level (see page 18, 
Accessing MINet).

1 Enter the IP addresses for the left and right terminals, 
enter codan in the Community frames, then click OK.

MINet connects to the left and right terminals. The 
configuration of the connected terminals is displayed. If 
these terminals have just been installed, the factory-
default configuration is displayed.

If either connection fails, MINet prompts you to retry the 
connection process.

1 If the terminal to which you are connecting has a Y-cable 
or access panel connected, you will be asked if you want 
to load an alternate 1+1 link.
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1 If you want to load an alternate link click Yes, enter the 
IP addresses for the left and right terminals, enter codan 
in the Community frames, then click OK.

1 If you want to work off line, click Cancel.

NOTE

For information on working off line with 
existing configuration files see page 90, 
Opening an existing configuration from 
file.



Setting up a link

46  MINet Management Software User Guide

Setting up a configuration
When you start up MINet, you will be asked if you want to 
load an active configuration. If you load an active 
configuration, the DMR will connect to the terminals that you 
nominate, and in the case of a new installation, the parameters 
displayed are those of the factory-default configuration. You 
can change this configuration in the radio, then save this 
configuration to the PC for backup purposes. Alternatively, 
you may work off line with an existing backup configuration 
(see page 90, Opening an existing configuration from file).

When the IP addresses are entered, the default community 
authorisation is automatically inserted by MINet. Initially, the 
supervisor authorisation is read/write to enable the operator to 
perform all tasks required to make the link operational. The 
operator may change this authorisation as required (see 
page 63, Setting up a community name).

The procedure for changing the active configuration or an 
existing configuration file is the same. Depending on the 
parameter, you can enter new data, select new parameter 
values from a drop down list, or toggle the status of a 
parameter with a check box (see page 24, Changing 
parameters for a terminal). Unsaved parameter values are 
indicated with blue text. The operator can easily verify 
changes on the screen before saving the configuration file or 
updating the active configuration.

Certain link parameters must be identical at each terminal for 
the link to operate properly. In a 1+1 redundancy system, these 
link parameters must be identical at all terminals for 
redundancy operation. When the operator modifies parameters 
of one terminal that must be identical at both terminals, MINet 
automatically identifies these parameters. The system prompts 
the operator to copy the parameters to the other terminal, and 
for a 1+1 redundancy system, to the other link. Some 
parameters cannot be modified; these fields are greyed out.
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Codan recommends that you configure a link according to a 
pre-defined network plan. Example network plans for out-of-
band and in-band management are provided on page 123, 
Example network diagrams. The information displayed in the 
following screens is from these plans.

Setting up the link settings

To set up the link settings:

1 From the Functions menu, select Configuration, then 
Link Settings..., or click  in the tool bar.

NOTE
The content of the Link Settings dialog varies 
depending on the DIU installed and whether or 
not a Y-cable or access panel is connected.

NOTE For help with changing values see page 24, 
Changing parameters for a terminal.



Setting up a link

48  MINet Management Software User Guide

1 Enter or select Main and Extended information on the 
left terminal as required, using the descriptions in the 
following table as a guide.

CAUTION

Some information should be identical at 
both terminals for the link to operate. 
MINet will prompt you to copy 
information to the other terminal when you 
save the configuration. In a 1+1 
redundancy system, you are also prompted 
to copy the information to the other link.

NOTE Saving information does not update the 
information to the terminals.

Parameter Description

Link Name
(Main)

The name that identifies this link 
as part of your network.

Link ID
(Main)

A unique, terminal-to-terminal 
identifier in the range from 1 to 
10000.

DIU Number
(Main)

The Codan part number of the 
DIU. This is read from the IDU.

DIU Description
(Main)

The description that corresponds 
to the DIU Number. This is read 
from the IDU.

ODU Part Number
(Main)

The Codan part number of the 
ODU. This is read from the ODU.

ODU Description
(Main)

The description that corresponds 
to the ODU Part Number. This is 
read from the ODU.

Link Capacity
(Main)

The available options are 
dependent on the DIU installed.
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Channel Spacing 
(Main, Eth 10/100 
DIU only)

The spacing between centre 
frequencies of designated 
channels.

The spacings are:
� ETSI: 14, 28, or 56 MHz
� FCC: 12.5, 25, or 50 MHz

Channel spacing determines the 
data throughput of the link.

Channel Number
(Main)

The centre frequency of the 
transmit frequency.

The frequencies are nominally in 
250 kHz steps.

Tx Power
(Main)

The Tx power for this ODU.

The available range is �10 dB up 
to the maximum allowable Tx 
power for the ODU, in 1 dB steps.

System Up-Time
(Main)

The length of time that the link has 
been operational since the last cold 
reset.

Space Diversity
(Main, 1+1 
redundancy system 
only)

The type of redundancy mode. 
Select On for a 1+1 space diversity 
system, and Off for a 1+1 hot 
standby system.

Terminal Name
(Extended)

A unique name of the terminal, 
identifying the specific end of the 
link, e.g. A or B.

Terminal Location
(Extended)

The location of the terminal, 
e.g. geographical coordinates.

Contact Details
(Extended)

The details for a local 
contact/service person.

Parameter Description
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Force AIS on all 
T1s/E1s
(Extended)

An AIS may be injected on the 
data stream to maintain 
transmission at certain defined 
events.

FEC Correctable 
Bytes
(Extended)

The amount of FEC for the link.

This amount may be configured as 
10 or 20 when an Eth 10/100 DIU 
is installed. The value cannot be 
configured for other DIUs.

ODU Temperature
(Extended)

The operating temperature of the 
ODU in °C. This is read from the 
ODU.

Tx Power Level
(Extended)

The actual power level that is used 
for transmission. This is read from 
the ODU.

ATPC Control
(Extended)

ATPC provides feedback to the 
remote transmitter from the 
receiver, based upon a set of RSL 
thresholds set at the receiver.

If you enable ATPC, you must 
enter threshold and optimal values 
for the RSL, and timer parameters.

RSL Upper 
Threshold (ATPC)
(Extended)

The upper limit at which the 
receiver will inform the remote 
transmitter to reduce output 
power.

RSL Optimal Value 
(ATPC)
(Extended)

The required optimal received 
power level at the receiver.

RSL Lower 
Threshold (ATPC)
(Extended)

The lower limit at which the 
receiver will inform the remote 
transmitter to increase output 
power.

Parameter Description



Setting up a link

MINet Management Software User Guide 51

1 If you are working on line, update the active 
configuration (see page 77, Updating the active 
configuration for a new link).

ATPC Timeout
(Extended)

The ATPC timeout meets a 
regulatory requirement to enable 
or disable a timeout function for 
operation of ATPC at the 
maximum Tx power. If the 
timeout is enabled, you need to set 
a duration, the alarm condition, 
and subsequent events following 
the timeout.

ATPC Timer 
(Minutes)
(Extended)

The timer sets the length of time 
that the DMR will transmit at 
maximum power before applying 
an ATPC timeout. The timer may 
be set for 1 to 60 minutes, in 
1 minute intervals.

ATPC Timeout 
Alarm
(Extended)

The timeout alarm, if enabled, 
sends an alarm to the alarm log 
according to the severity level set 
below.

ATPC Timeout 
Alarm Level 
(Extended)

If a timeout alarm is enabled, this 
sets the level of the alarm sent to 
the log.

Disable ATPC at 
Timeout Alarm
(Extended)

If a timeout alarm is generated and 
this option is set to On, the Tx 
power level is reset to the nominal 
value (10 dB lower than the Tx 
power level set on the Main tab).

NOTE

When you update the active configuration 
in a 1+1 redundancy system, you may be 
prompted to copy information to the other 
terminal, then the other link.

Parameter Description
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1 Enter or select Main and Extended information for the 
right terminal as required, then update the active 
configuration.

1 In a 1+1 redundancy system, select the other link and 
enter appropriate information for the left and right 
terminals, then update the active configuration.

1 If you are working off line, from the File menu, select 
Save to save the configuration file.

1 If you want to save the log file see page 92, Saving an 
alarm log file.

NOTE A configuration file must be saved for all 
terminals in a 1+1 redundancy system.
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Setting up the interfaces

To set up the interfaces:

1 From the Functions menu, select Configuration, then 
Interfaces..., or click  in the tool bar.

Each type of interface has a tab.

1 Select the interface tab that you want to set up.

Each port for the interface is configured separately.

1 Enter or select information for the E1/E3 or DS1/DS3 
DIUs on the left terminal as required, using the 
descriptions in the following table as a guide.

NOTE

The content of the Interfaces dialog varies 
depending on the DIU installed and the link 
capacity (see page 47, Setting up the link 
settings).

NOTE For help with changing values see page 24, 
Changing parameters for a terminal.
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1 Enter or select information for the E1/E3 or DS1/DS3 
DIUs on the right terminal as required.

Parameter Description

Encoding The encoding for the port must 
match the encoding of the device 
attached to the tributary line.

The encoding for each port must 
be identical at both terminals.

This encoding may be configured 
for DS1/DS3 DIUs only.

Control A port can be enabled to pass data, 
or it can be disabled.

When a port is disabled, any 
alarms for this port are also 
disabled.

Status The status of the port, read from 
the IDU. For more information on 
viewing the status of the E1/E3 or 
DS1/DS3 tributary see Table 1 on 
page 94.

Inverted Alarms An alarm contact for the attached 
device may be configured for 
inverted operation (opens on 
alarm) or non-inverted operation 
(closes on alarm).

Port Name The name for the port, e.g. you 
may use the name of the attached 
device.
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1 Enter or select information for the Eth 10/100 DIU on the 
left terminal as required, using the descriptions in the 
following table as a guide.

Parameter Description

Flow Control The terminals can use a 
handshaking protocol, or this can 
be disabled.

Port Control A port can be enabled to pass data, 
or it can be disabled.

When a port is disabled, any 
alarms for this port are also 
disabled.

Port Status The status of the port, read from 
the DIU. For more information on 
viewing the status of the Eth 
10/100 tributary see Table 1 on 
page 94.

Auto Negotiation The ports can negotiate their 
communication requirements or 
have these requirements selected 
for them.

If you switch off auto negotiation, 
you must select values for Speed 
Control and Duplex Control.

Speed Control The speed of data transmission 
that is set for the link.

Speed Status The actual speed of data 
transmission over the link. For 
more information on viewing the 
status of the Eth 10/100 tributary 
see Table 1 on page 94.

Duplex Control The method of data transmission 
that is set for the link. It can be full 
or half duplex.
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1 Enter or select information for the Eth 10/100 DIU on the 
right terminal as required.

1 Select information for each service (the physical ports on 
the IDU) on the left terminal as required, using the 
descriptions in the following table as a guide.

Duplex Status The actual duplex control used for 
the data transmission over the link. 
For more information on viewing 
the status of the Eth 10/100 
tributary see Table 1 on page 94.

Force Disconnect The Eth 10/100 DIU port can be 
forced to disconnect as a result of 
a link-down indication. This is 
used in conjunction with spanning 
tree protocol for redundancy LAN 
applications.

Throughput Control A guaranteed port speed may be 
set on a port by port basis.

Parameter Description

MAC Address This is the unique hardware 
address of every Ethernet card. 
This is read from the ETH port on 
the IDU, and from the Eth 10/100 
DIU, if fitted.

Flow Control The NMS-IN, NMS-OUT, DATA 
and TEST ports on the IDU can 
use a handshaking protocol.

Bits
Stop Bits
Parity Bit
Baud Rate

The communication requirements 
for the device attached to the 
NMS-IN, NMS-OUT, DATA and 
TEST ports.

Parameter Description



Setting up a link

MINet Management Software User Guide 57

1 Select information for each service on the right terminal 
as required.

1 Update the active configuration (see page 77, Updating 
the active configuration for a new link).

1 In a 1+1 redundancy system, select the other link and 
enter appropriate information for the left and right 
terminals, then update the active configuration.

1 If you are working off line, from the File menu, select 
Save to save the configuration file.

1 If you want to save the log file see page 92, Saving an 
alarm log file.

Setting up IP addresses and subnet masks for each port 
on the IDU

Each port on the IDU may be attached to an external device, 
and each of these devices needs to be allocated its own IP 
address. Similarly, information from these external devices 
(such as alarms and traps) needs to be directed to destinations 
where appropriate action can be taken. To do this, each 
terminal needs to store information on its location within the 
network, so that information can be sent via the most direct 
route to other terminals.

NOTE The TEST port is for factory-use only.

NOTE A configuration file must be saved for all 
terminals in a 1+1 redundancy system.

NOTE

The content of the IP and Peer IP tabs in the 
Management dialog varies depending on the 
DIU installed and whether or not a Y-cable or 
access panel is connected.
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Configurations that have E1/E3 or DS1/DS3 type DIUs use 
out-of-band management only. Eth 10/100 DIUs have the 
option to use either in-band or out-of-band management, or 
both. In-band management uses some of the link�s customer-
traffic bandwidth for management purposes. Out-of-band 
management uses a dedicated 64 KB peer channel for link 
management purposes between the terminals.

To set up the IP addresses and subnet masks:

1 From the Functions menu, select Configuration, then 
Management..., or click  in the tool bar.

1 Select the IP tab.

NOTE For help with changing values see page 24, 
Changing parameters for a terminal.

212.180.1.100
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1 Enter the IP address and subnet mask for each physical 
port on the IDU for the left terminal as required, using 
the descriptions in the following table as a guide.

1 Enter IP information for the right terminal as required.

Interface Description

NMS In (SLIP) The NMS-IN port is allocated an 
IP address to provide out-of-band 
management of the link. 
Management via a modem and 
standard dial-up telephone line is 
provided through this port. This 
port is used to cascade terminals 
via SLIP at a site.

NMS Out (SLIP) The NMS-OUT port connects to 
an NMS-IN port and is used for 
cascading IDUs.

Link The link is allocated an IP address 
to provide downstream 
management via the RF path.

ETH The ETH port is used for out-of-
band management of configured 
terminals.

Eth 10/100 Mng
(Eth 10/100 DIU 
only)

The ETH 10/100 Mng port is 
used for in-band management of 
terminals where an Eth 10/100 
DIU is installed.

NMS In (SLIP) 
Dest

NMS In/Out (SLIP) Dest are IP 
addresses that enable routing of 
NMS-IN to NMS-OUT between 
two links at a repeater site.NMS Out (SLIP) 

Dest

Alternate ETH IP
(1+1 redundancy 
system only)

The ETH IP address of the backup 
terminal.
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1 Update the active configuration (see page 77, Updating 
the active configuration for a new link).

The Peer IP tab shows the IP address table of the 
terminal at the other end of the link.

1 In a 1+1 redundancy system, select the other link and 
enter appropriate information for the left and right 
terminals, then update the active configuration.

1 If you are working off line, from the File menu, select 
Save to save the configuration file.

1 If you want to save the log file see page 92, Saving an 
alarm log file.

NOTE A configuration file must be saved for all 
terminals in a 1+1 redundancy system.

212.180.1.100
212.180.1.100
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Setting up a routing table
A routing table contains static routes that have been added to 
each terminal. Generally, if RIP protocol is enabled for the 
terminal, a static routing table is not required.

To set up a routing table:

1 Connect to the active configuration in which you want to 
set up the routing table (see page 44, Loading the active 
configuration).

1 From the Functions menu, select Configuration, then 
Management..., or click  in the tool bar.

1 Select the Routing Table tab for the left terminal.

CAUTION Static routes should only be added to a terminal 
by an experienced IP network administrator.

NOTE For help with changing values see page 24, 
Changing parameters for a terminal.

10.0.100.0
10.0.101.0

192.168.13.67
192.168.13.92
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1 Enter an IP address into the Destination IP field, then 
click Add.

The terminal communicates with the destination IP 
address.

The Next Hop, Route Mask, and Interface fields are 
filled automatically from the exchanged information.

1 If you want to delete an IP address and associated hop 
and route mask information, select the IP address, then 
click Delete.

1 Enter IP addresses for the right terminal as required.

1 Update the active configuration (see page 77, Updating 
the active configuration for a new link).

1 In a 1+1 redundancy system, select the other link and 
enter appropriate information for the left and right 
terminals, then update the active configuration.

1 From the File menu, select Save to save the 
configuration file.

1 If you want to save the log file see page 92, Saving an 
alarm log file.

NOTE A configuration file must be saved for all 
terminals in a 1+1 redundancy system.
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Setting up a community name
A community name is a basic SNMP convention that is used 
to provide system security. 

To set up the community name:

1 From the Functions menu, select Configuration, then 
Management..., or click  in the tool bar.

1 Select the Community and Traps tab for the left 
terminal.

1 In the Community frame, Community field, enter the 
name of a community that will be using the link.

The community designation may be any alphanumeric 
string.

NOTE For help with changing values see page 24, 
Changing parameters for a terminal.



Setting up a link

64  MINet Management Software User Guide

1 Select the type of access privilege that you want this 
community to have from the corresponding drop list in 
the Privilege field, using the descriptions in the 
following table as a guide.

1 Enter or select community and privilege information for 
the right terminal as required, then update the active 
configuration.

1 Update the active configuration (see page 77, Updating 
the active configuration for a new link).

1 In a 1+1 redundancy system, select the other link and 
enter appropriate information for the left and right 
terminals, then update the active configuration.

1 If you are working off line, from the File menu, select 
Save to save the configuration file.

1 If you want to save the log file see page 92, Saving an 
alarm log file.

Value Description

Read Only Operators logged in as 
User/Administrator/Supervisor 
have read access only.

Read Write Operators logged in as User have 
read access only.

Operators logged in as 
Administrator have limited 
read/write access.

Operators logged in as Supervisor 
have full read/write access.

NOTE A configuration file must be saved for all 
terminals in a 1+1 redundancy system.
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Setting up trap handling
SNMP v2 has the ability to highlight an event occurring in a 
network, and send notification of this event (known as a trap) 
from the SNMP agent to the SNMP manager. The 8800 series 
DMR can raise traps and send these to a network manager. 
The event causing the trap (for example, a hardware fault or a 
general performance parameter such as RSL), and the 
recipient of the trap can be configured easily using MINet.

To set up trap handling:

1 From the Functions menu, select Configuration, then 
Management..., or click  in the tool bar.

1 Select the Community and Traps tab for the left 
terminal.

1 In the Trap Recipients frame, IP field, enter the IP 
address of the SNMP manager.

1 In the Traps frame, select the corresponding box for 
events that you want to have reported as traps.

NOTE For help with changing values see page 24, 
Changing parameters for a terminal.
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If you do not want to have an event reported as a trap, 
ensure that the corresponding box is not selected.

1 In the Heart Beat frame, Interval field, select the 
frequency with which you want status traps sent to trap 
recipients.

1 In the Heart Beat frame, select the corresponding box 
for information that you want to have included in the 
status report, using the descriptions in the following table 
as a guide.

If you do not want to send a status report at a regular 
interval, ensure that all boxes are not selected.

1 Enter trap information for the right terminal as required, 
then update the active configuration.

1 Update the active configuration (see page 77, Updating 
the active configuration for a new link).

1 In a 1+1 redundancy system, select the other link and 
enter appropriate information for the left and right 
terminals, then update the active configuration.

1 If you are working off line, from the File menu, select 
Save to save the configuration file.

1 If you want to save the log file see page 92, Saving an 
alarm log file.

NOTE Any events that are selected are sent to all 
trap recipients.

Parameter Description

RSL The received signal level.

BER The current BER for the link.

UAS The unavailable seconds for the 
link.

NOTE A configuration file must be saved for all 
terminals in a 1+1 redundancy system.
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Setting up input/output alarms for the link
Output relays are used to control external equipment 
connected to the Codan 8800 series DMR system. The 
equipment is generally not directly related to communications. 
Such equipment could be a UPS, air-conditioning system, 
buzzer, lights etc. Relays enable the IDU to respond to a 
defined set of conditions.

External inputs with an analog signal range of 2.5 to 9 V are 
used to alert the Codan 8800 series DMR terminal of events 
occurring outside the terminal.

When relay outputs and external inputs are used, a cable is 
connected between the external equipment and the ALARMS 
port on the IDU. A DB25 connector includes both relay 
outputs and external inputs. Wiring can enable up to five 
relays to be connected, plus an additional relay connected to a 
buzzer inside the IDU. Alarms are generated for the 
equipment in accordance with the parameters in the Relays 
dialog. You can activate up to four external inputs and view 
their status in the External Inputs dialog.
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To set up input/output alarms:

1 From the Functions menu, select Configuration, then 
Relays..., or click  in the tool bar.

1 Select the Control tab for the left terminal.

This tab contains parameters that determine whether the 
accessory equipment is enabled, and if so, when and how 
it should be activated.

NOTE For help with changing values see page 24, 
Changing parameters for a terminal.
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1 Select the status that you want for each of the relays and 
the buzzer, using the descriptions in the following table 
as a guide.

1 From the Functions menu, select Configuration, then 
External Inputs..., or click  in the tool bar.

Parameter Description

Enable/Disable The relay and buzzer can be 
enabled or disabled.

The relay must be enabled if you 
want to map it to an alarm.

Normal State The relay output can be defined as 
normally open or normally closed.

Forced Activation When forced activation is on, the 
relay/buzzer is active.

Status The status of the relay, read from 
the IDU. For more information on 
viewing the status of the relays see 
Table 1 on page 94.

NOTE For help with changing values see page 24, 
Changing parameters for a terminal.
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1 On the left terminal, select the status that you want for 
each of the external inputs, the sense, and the severity, 
using the descriptions in the following table as a guide.

1 From the Functions menu, select Configuration, then 
Relays..., or click  in the tool bar.

1 Select the Mapping tab for the left terminal.

You are able to assign a defined set of events at the local 
terminal against each output relay or external input, and 
activate the buzzer if required. The actual number of 
events depends on the IDU configuration and the number 
of supported tributary lines.

Parameter Description

Enable/Disable An alarm status is logged in the 
alarm log when this input 
activates. If the buzzer relay is 
also mapped and enabled, the 
buzzer sounds when this input 
alarms.

If the external input is disabled, an 
alarm status is not logged.

Sense The input alarms on a low, a high, 
or any change to the current 
operator-defined status.

Severity The alarm may be either a warning 
or indication of a fatal error. 
Active inputs may be filtered and 
sorted by levels of severity.

Status/State The status of the input, read from 
the IDU. For more information on 
viewing the status of the inputs see 
Table 1 on page 94.
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1 Select the box corresponding to the event that you want 
to have indicated by a specific ALARM LED on the 
front panel of the IDU.

If you want the internal buzzer to sound for this event, 
select the corresponding Buzzer box for the event.

1 Enter or select input/output alarm information for the 
right terminal as required.

1 Update the active configuration (see page 77, Updating 
the active configuration for a new link).

1 In a 1+1 redundancy system, select the other link and 
enter appropriate information for the left and right 
terminals, then update the active configuration.

1 If you are working off line, from the File menu, select 
Save to save the configuration file.

1 If you want to save the log file see page 92, Saving an 
alarm log file.

NOTE A configuration file must be saved for all 
terminals in a 1+1 redundancy system.
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Setting up performance measures for the link

To set up performance measures:

1 From the Functions menu, select Status, then 
Performance..., or click  in the tool bar.

1 Select the Link Thresholds tab for the left terminal.

1 Enter the low to high and high to low thresholds that you 
want for each parameter, using the descriptions in the 
following table as a guide.

NOTE The content of the Performance dialog varies 
depending on the DIU installed.

NOTE For help with changing values see page 24, 
Changing parameters for a terminal.
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1 Enter the low to high and high to low thresholds that you 
want for each parameter on the right terminal as required.

Parameter Description

Unavailable 
seconds

The percentage of unavailable 
time since the last clear of 
statistics.

Errored seconds The percentage of errored seconds 
since the last clear of statistics. 

Severely-errored 
seconds

The percentage of severely-
errored seconds since the last clear 
of statistics.

Corrected blocks 
rate

The number of errored blocks per 
second that are corrected by the 
internal FEC of the DMR.

BBER The number of block errors 
occurring in a one-second period 
that did not occur as part of an 
SES.

NCBLER The number of errored blocks per 
second that are not corrected by 
the internal FEC of the DMR.

BER Warning The level of BER at which a 
warning alarm is indicated or 
removed.

BER Fatal The level of BER at which a fatal 
error is indicated or resolved.

Current RSL The actual RSL in dBm measured 
at the receiver. If the current 
reading moves outside these 
thresholds, an alarm is indicated.

Average RSL The average RSL in dBm over the 
period since the last clear of 
statistics.
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1 If you are using an Eth 10/100 DIU, select the Eth 
10/100 Thresholds tab on the left terminal, then enter 
the thresholds that you want for each parameter, using 
the descriptions in the following table as a guide.

1 If you are using an Eth 10/100 DIU, select the Eth 
10/100 Thresholds tab, then enter the thresholds that 
you want for each parameter on the right terminal as 
required.

1 Update the active configuration (see page 77, Updating 
the active configuration for a new link).

1 In a 1+1 redundancy system, select the other link and 
enter appropriate information for the left and right 
terminals, then update the active configuration.

1 If you are working off line, from the File menu, select 
Save to save the configuration file.

1 If you want to save the log file see page 92, Saving an 
alarm log file.

Parameter Description

Eth 10/100 Tx Link 
Usage

The percentage of available 
bandwidth utilised during 
transmit.

Eth 10/100 Rx Link 
Usage

The percentage of available 
bandwidth utilised during receive.

NOTE A configuration file must be saved for all 
terminals in a 1+1 redundancy system.
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Setting up polling parameters for the link
To set up the polling parameters:

1 From the Options menu, select NMS Management..., 
or click  in the tool bar.

1 Enter SNMP parameters for MINet as required, using the 
descriptions in the following table as a guide.

Parameter Description

Timeout The length of time that the NMS 
waits for a response from the IDU.

Number of Retries The number of times that the NMS 
tries to poll for information before 
reporting that the poll has failed.
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1 Enter the interval (in seconds) at which you want to 
receive the following information.

If you do not want to receive the information, clear the 
corresponding check box.

1 Click OK.

Parameter Description

Configuration Polls all operator-changeable 
configuration parameters.

Status Polls events such as alarms, 
counters and status. When status 
polling is in progress, a message 
appears on the left-hand side of the 
status bar.

Performance Polls the results of performance 
indicators such as BER, RSL, 
unavailable time etc.

NOTE

For systems with heavy communications 
traffic, it is recommended that longer 
polling intervals be used to reduce the 
number of management frames that are 
sent.
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Updating the active configuration for a new 
link

The active configuration is used by the Codan 8800 series 
DMR system to operate the link. It is stored in the IDU.

To update the active configuration:

1 From the Link Operations menu, select Update 
Active Configuration, or click  in the tool bar.

NOTE

During initial set up of a 1+1 redundancy 
system, the order in which the active 
configurations are updated is not critical. If you 
are updating the active configurations of a 1+1 
redundancy system that has been fully 
commissioned and is operational, you must 
follow the process provided on page 87, 
Updating the active configuration for an 
operational link.
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1 Click on the drop arrow in the IP Address field for the 
left and right terminals to select a previously-connected 
terminal, or enter the IP addresses of the new terminals, 
then click OK.

MINet remembers the correct SNMP community name 
for the selected IP address.

1 If you do not want to update a terminal, click Selected 
for the terminal that you do not want to update.

The graphic representation of the terminal turns pale 
pink. To select the terminal again, click Unselected for 
the terminal that you want to select.

1 If you want to update both terminals, select the terminal 
you want to update first, then click OK.

1 Cold reset the terminals when prompted.

MINet updates the terminals, as required.

1 In a 1+1 redundancy system, update the other link when 
prompted if you have made changes.

CAUTION
The terminal that is at the greatest number 
of hops from the management PC must be 
updated first.

NOTE

The number of network hops to each 
terminal may be determined from the TTL 
count in the ping response. The terminal 
with the lowest TTL count is the furthest 
away from the management PC and must 
be updated first.
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Saving the active configuration to file
The active configuration is saved in a manner similar to saving 
Microsoft Windows files.

To save an active configuration to file:

1 Do one of the following:

� To save the current configuration under the same name, 
from the File menu, select Save (Ctrl + S).

� To save the current configuration under a new name, 
from the File menu, select Save as... (Ctrl + A).

A warning message appears to remind you that you must 
save alarm log files separately. When a configuration is 
saved, the alarms that were generated for that 
configuration, up to the time that the Save was 
performed, are recorded in a separate alarm log file. For 
more information see page 92, Saving an alarm log file.

CAUTION

Saving a configuration file is not the same as 
updating the active configuration. To update the 
active configuration see page 77, Updating the 
active configuration for a new link.
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�����6 Operating MINet

This section contains the following topics:

Modes of operation (82)

Loading the active configuration (85)

Updating the active configuration for an operational link (87)

Creating a new configuration file (89)

Opening an existing configuration from file (90)

Saving a configuration to file (91)

Closing a configuration file (92)

Saving an alarm log file (92)

Viewing the key operational parameters of a 1+0 link (93)

Viewing the status for a link (94)

Viewing the performance of a link (96)

Viewing the alarms for a link (100)

Performing tests on a link (104)

Upgrading firmware in the DMR (108)

Switching over the firmware memory banks (111)

Restricting access to the configuration of the 8800 series 
DMR (113)

Changing the current access level in MINet (117)

Resetting a link or an individual terminal (118)

Setting the factory-default configuration (120)

If technical assistance is required... (122)

NOTE
This section assumes that the communications 
hardware is operating properly and that MINet 
is set up correctly.
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Modes of operation
MINet may be operated in any of the following modes:

� on line

� off line

� using saved files

While in any of the above modes, you can also be operating 
as:

� normal

� config

� basic

� advanced

On-line mode

On-line mode is accessed when MINet is connected to and 
communicating with a terminal, or pair of terminals, for 
loading or updating the active configuration stored in the 
terminal or terminals.

To access On-line mode, load an active configuration (see 
page 85, Loading the active configuration).

When you are in On-line mode, ONLINE is displayed in the 
status bar.

Off-line mode

Off-line mode is accessed when MINet is not connected to or 
communicating with a terminal, and not using a saved 
configuration file. Off-line mode indicates that MINet is 
running, however, no configuration is possible.

When you are in Off-line mode, OFFLINE is displayed in the 
status bar.
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File mode

File mode is accessed when a saved configuration file is 
opened, or you save an active configuration from a terminal, 
or pair of terminals, to a configuration file on a PC for backup 
purposes. You can open a saved configuration file and make 
changes to the configuration, then change to On-line mode to 
update the active configuration at a terminal, or pair of 
terminals. A configuration file can be transmitted to Codan for 
technical support.

To access File mode, open a saved configuration file (see 
page 90, Opening an existing configuration from file), or save 
an active configuration (see page 91, Saving a configuration 
to file).

When you are in File mode, FILE is displayed in the status 
bar.

Normal mode

Normal mode indicates that link parameters are being 
monitored.

When you are in Normal mode, NORMAL is displayed in the 
status bar.

Config mode

Config mode indicates that link parameters are being 
modified.

When you are in Config mode, CONFIG is displayed in the 
status bar.

Basic mode

Basic mode is reserved for future development.

When you are in Basic mode, BASIC is displayed in the status 
bar.
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Advanced mode

Advanced mode enables full configuration of the link.

When you are in Advanced mode, ADVANCED is displayed 
in the status bar.



Operating MINet

MINet Management Software User Guide 85

Loading the active configuration
A configuration may be read from an IDU into MINet for 
monitoring, configuration, or management purposes.

To load the active configuration:

1 Access MINet at Supervisor level (see page 18, 
Accessing MINet).

1 Click on the drop arrow in the IP Address field for the 
left and right terminals to select a previously-connected 
terminal, then click OK.

MINet remembers the correct SNMP community name 
for the selected IP address.

MINet connects to the left and right terminals. A 
progress bar appears indicating that the active 
configuration is being loaded. The configuration of the 
connected terminals is displayed.

If either connection fails, MINet prompts you to retry the 
connection process.

1 If the terminal to which you are connecting has a Y-cable 
or access panel connected, you will be asked if you want 
to load an alternate 1+1 link.
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1 If you want to load an alternate link click Yes, enter the 
IP addresses for the left and right terminals, enter codan 
in the Community frames, then click OK.

1 If you want to change the active configuration see 
page 46, Setting up a configuration.

CAUTION

If you want to change the active 
configurations of a 1+1 redundancy 
system, change the non-active link first 
(see Figure 3 on page 22 and page 24, 
Selecting a terminal in a 1+1 redundancy 
system).
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Updating the active configuration for an 
operational link

The active configuration is used by the Codan 8800 series 
DMR system to operate the link. It is stored in the IDU.

To update the active configuration:

1 From the Link Operations menu, select Update 
Active Configuration, or click  in the tool bar.

1 Click on the drop arrow in the IP Address field for the 
left and right terminals to select a previously-connected 
terminal, then click OK.

MINet remembers the correct SNMP community name 
for the selected IP address.

1 If you do not want to update a terminal, click Selected 
for the terminal that you do not want to update.

CAUTION

If you want to update the active configurations 
of a 1+1 redundancy system, update the non-
active link first (see Figure 3 on page 22 and 
page 24, Selecting a terminal in a 1+1 
redundancy system).
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The graphic representation of the terminal turns pale 
pink. To select the terminal again, click Unselected for 
the terminal that you want to select.

1 If you want to update both terminals, select the terminal 
you want to update first, then click OK.

1 Cold reset the terminals when prompted.

MINet updates the terminals, as required.

1 In a 1+1 redundancy system, update the other link when 
prompted if you have made changes.

CAUTION
The terminal that is at the greatest number 
of hops from the management PC must be 
updated first.

NOTE

The number of network hops to each 
terminal may be determined from the TTL 
count in the ping response. The terminal 
with the lowest TTL count is the furthest 
away from the management PC and must 
be updated first.
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Creating a new configuration file

To create a new configuration file:

1 Access MINet at Supervisor level (see page 18, 
Accessing MINet).

1 Load the active configuration of the terminal that you 
want to use as a basis for a new configuration (see 
page 85, Loading the active configuration).

1 From the File menu, select Save, or click  in the tool 
bar.

CAUTION
Configuration files contain vital link 
information. Do not tamper with these files. 
Modify these files using MINet only.



Operating MINet

90  MINet Management Software User Guide

Opening an existing configuration from file

To open an existing configuration file:

1 Access MINet at Supervisor level (see page 18, 
Accessing MINet).

1 Click Cancel to work off line.

1 From the File menu, select Open..., or click  in the 
tool bar.

1 Navigate to the directory that contains existing .cfg and 
.cfs files for the configuration.

1 Select the .cfg file that you want to open, then click 
Open.

The configuration is opened. The MINet window 
displays the link, using the last known status. The Link 
Setting dialogs for each terminal are displayed, and the 
status bar indicates that MINet is operating in File mode.

CAUTION
Configuration files contain vital link 
information. Do not tamper with these files. 
Modify these files using MINet only.

CAUTION

The .cfs file for each terminal must be 
present in this directory to open the 
associated .cfg file. You may need to show 
all file types.
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Saving a configuration to file
If you want to modify an existing configuration stored on a 
PC, you must save the changes. Saving a configuration to file 
is performed in a manner similar to saving Microsoft 
Windows files.

To save a configuration:

1 Do one of the following:

� To save the current configuration under the same name, 
from the File menu, select Save (Ctrl + S).

� To save the current configuration under a new name, 
from the File menu, select Save as... (Ctrl + A).

A warning message appears to remind you that you must 
save alarm log files separately. When a configuration is 
saved, the alarms that were generated for that 
configuration, up to the time that the Save was 
performed, are recorded in a separate alarm log file. For 
more information see page 92, Saving an alarm log file.

CAUTION

Saving a configuration is not the same as 
updating the active configuration. To update the 
active configuration see page 87, Updating the 
active configuration for an operational link.
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Closing a configuration file
To close a configuration file:

1 From the File menu, select Close.

If there are unsaved changes in the file, MINet prompts 
you to save these changes.

Saving an alarm log file
To save the alarm log file for a terminal:

1 From the Functions menu, select Status, then 
Alarms..., or click  in the tool bar.

1 Select the Log tab.

1 Sort and show entries in the log as required.

1 Click  (Save Alarms Log to File).

The Save as dialog is displayed.

1 Modify the existing name and path as required, then click 
Save.
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Viewing the key operational parameters of a 
1+0 link

You can view the key operational parameters for an active 
link, or view these in a saved configuration file. You cannot 
view the status of a link while you are in Off-line mode.

The status of key operational parameters for the configuration 
are displayed in the MINet window, as shown in Figure 8 and 
Figure 9.

Figure 8: Key operational parameters (E1/E3 or 
DS1/DS3 DIU)

Figure 9: Key operational parameters (Eth 10/100 DIU)
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Viewing the status for a link

Table 1 shows the various parameters for which you can view 
status information, and how to access this information in 
MINet. The status information is displayed in one of the 
following colours:

Colour Description of status

Grey Not active

Green OK

Yellow Warning

Orange Operator control

Red Fatal

Table 1: Status information 

To access this status 
information...

On the menu bar, select...

1+1 Functions�Configuration�Management...�
1+1 Status

Alternate firmware version (IDU) Functions�Status�Components Revisions...

Boot version (IDU) Functions�Status�Components Revisions...

DS1/DS3 tributary Functions�Configuration�Interfaces...�
DS1/DS3 tab

E1/E3 tributary Functions�Configuration�Interfaces...�
E1/E3 tab

Eth 10/100 tributary Functions�Configuration�Interfaces...�
Eth 10/100 tab

External inputs Functions�Configuration�External 
Inputs...�Control tab
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Firmware version (IDU, ODU) Functions�Status�Components Revisions...

Hardware version (IDU, DIU, 
ODU)

Functions�Status�Components Revisions...

Link performance Functions�Status�Performance...�Link tab

Output relay Functions�Configuration�Relays...�
Control tab

Part number (IDU, DIU, ODU) Functions�Status�Components Revisions...

Serial number (IDU, DIU, ODU) Functions�Status�Components Revisions...

Tx Mute Functions�Operations�Test...�Operations 
tab

Table 1: Status information (cont.)

To access this status 
information...

On the menu bar, select...
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Viewing the performance of a link

You can view the performance of an active link, or view these 
in a saved configuration file. You cannot view the 
performance of a link while you are in Off-line mode.

Some parameters are set by the operator, others are calculated 
by the system on the basis of operator settings, and others are 
calculated by the system, independent of operator settings. 
The performance information is displayed in one of the 
following colours:

To view the performance information:

1 From the Functions menu, select Status, then 
Performance..., or click  in the tool bar.

NOTE The content of the Performance dialog varies 
depending on the DIU installed.

Colour Description of status

Grey Not active

Green OK

Yellow Warning

Orange Operator control

Red Fatal
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The following performance information may be 
displayed:

Tab Description

Link This tab displays major link 
performance statistics relative to 
an elapsed time period, which is 
determined by the selection made 
in the Period Mode field. The 
statistics displayed are: elapsed 
time, error-free seconds, 
unavailable seconds, errored 
seconds, severely-errored seconds, 
background block error rate, not 
corrected block error rate, and bit 
errror rate.
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Link Thresholds This tab sets the BER and RSL 
performance thresholds of the link 
during operation (see page 72, 
Setting up performance measures 
for the link). The values set here 
determine the level at which an 
alarm activates (low to high), and 
when the alarm deactivates (high 
to low).

RSL This tab displays RSL 
performance statistics relative to 
an elapsed time period, which is 
determined by the selection made 
in the Period Mode field. The 
current RSL is displayed in a 
colour-coded field, indicating its 
status according to the threshold 
set above. The statistics displayed 
are: elapsed time, average RSL, 
maximum RSL, and minimum 
RSL since the last reset.

Eth 10/100 
Statistics
(Eth 10/100 DIU 
only)

This tab displays Eth 10/100 
performance statistics for each 
Ethernet port on the DIU. The 
statistics displayed are: input and 
output octets, alignment errors, 
FCS errors, single and multiple 
collision frames, SQE test errors, 
deferred transmissions, late and 
excessive collisions, carrier sense 
errors, and oversize frames.

Tab Description
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Eth 10/100 
Utilisation
(Eth 10/100 DIU 
only)

This tab displays utilisation 
statistics for transmit and receive 
over an Ethernet link. The 
statistics displayed are: link usage 
(Mbps), and Tx/Rx link utilisation 
(%).

The statistics displayed comply 
with the Ethernet MIB standard.

Clear This tab clears the performance 
statistics of the link and restarts all 
counters.

Eth 10/100 
Thresholds

This tab sets the Eth 10/100 
thresholds of the link during 
operation (see page 72, Setting up 
performance measures for the 
link). The values set here 
determine when the terminal 
shows an alarm for Ethernet 
utilisation as a percentage of the 
total utilisation.

Tab Description
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Viewing the alarms for a link

You can view the alarms for an active link, or view these in a 
saved configuration file. You cannot view the alarms for a link 
while you are in Off-line mode.

MINet monitors the alarm status for all the major components 
of the 8800 series DMR system comprising:

� link

� ODU

� IDU

� tributaries

� Eth 10/100 (if used)

The alarm information is displayed in one of the following 
colours:

NOTE
The content of the Alarms dialog varies 
depending on the DIU installed and whether or 
not a Y-cable or access panel is connected.

Colour Description of status

Green OK

Yellow Warning

Orange Operator control

Red Fatal
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To view the alarm status:

1 From the Functions menu, select Status, then 
Alarms..., or click  in the tool bar.

The following alarm status information may be 
displayed:

Tab Description

Summary This tab displays a top level 
summary of the alarm status of 
each component of the 8800 series 
DMR. The alarms are: link, ODU, 
IDU, E1/E3 or DS1/DS3, and 
Eth 10/100 (if used).
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Link This tab displays alarm status 
information for the link. The 
alarms displayed are: link down, 
remote terminal not accessible, 
remote terminal failure and 
warning, unavailable seconds, 
errored seconds, severely-errored 
seconds, block error rates, bit error 
rates, RSL, and link ID violation.

If you want to view the thresholds 
that have been set for the link, 
click Thresholds to display the 
Link Thresholds tab in the 
Performance dialog.

ODU This tab displays alarm status 
information for the ODU. The 
alarms displayed are: transmitter 
failure, ODU internal failure (Tx, 
Rx, RF, Power, OF), telemetry, 
ODU not responding, receiver 
failure, ODU temperature 
violation, and transmitter mute.

IDU This tab displays alarm status 
information for the IDU. The 
alarms displayed are: IDU internal 
failure (Tx, Rx, Power), telemetry, 
modem synchronisation, and 
external inputs.

E1/E3 or DS1/DS3 This tab displays alarm status 
information for each tributary port 
used. The port monitors what is 
being transmitted on the channel, 
and if Tx AIS is present, the status 
is shown as active.

Tab Description
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Log This tab displays a list of 
accumulated alarms for the 
8800 series DMR. You can sort 
alarms according to severity, time 
or description, and whether or not 
they are active, and you can show 
alarms according to the severity. 
You can clear all the alarms from 
this tab. If you want to save a 
record of the alarms on this tab see 
page 92, Saving an alarm log file.

Tab Description
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Performing tests on a link
Two tests are provided for link maintenance. To perform a test 
on a link, you must be on line. The tests that you can perform 
are:

� loopback

� Tx mute control

Loopback test
Loopback tests are performed for maintenance and fault 
finding. Loopback tests may be applied to the IDU, ODU, or 
to the individual E1/DS1 tributaries. The IDU or ODU 
loopback affects all traffic on the DMR, and should only be 
used for maintenance purposes when a technician is at the site.

Tributary loopbacks only affect the channel being looped 
back. Such loopbacks may be applied over network 
management without affecting other tributary traffic or 
management traffic. Loopbacks may be applied on the local 
IDU, or remotely to the far end of the link.

CAUTION Network management may be lost when using 
the IDU or ODU loopback test.

CAUTION
Once an IDU or ODU is placed in loopback 
mode, you must switch the DMR off then on 
again to return to normal operation.
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To perform a loopback test:

1 From the Functions menu, select Operations, then 
Test..., or click  in the tool bar.

1 Select the Loopback tab.

1 If you want to loopback the IDU, select the IDU 
Loopback box.

1 Select any tributaries that you want to test, and whether 
the loopback is performed locally (local IDU port 
loopback), or across the link (remote IDU port 
loopback).

NOTE
ODU RF Loopback may be available on 
some frequency bands. It will be displayed 
on the dialog if it is available.

NOTE
A remote loopback loops the selected 
tributary on the remote terminal back to the 
local end.
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Tx Mute Control test
The Tx Mute function lowers the Tx power level to effectively 
switch off the transmitter. The Tx power level in a muted state 
is always < �45 dBm. It may be applied permanently, or for a 
pre-determined period of time. This feature may be used 
during installation or during commissioning to check if 
interference is present.

To mute the transmitter:

1 From the Functions menu, select Operations, then 
Test..., or click  in the tool bar.

1 Select the Operations tab.

1 In the Tx Mute field, select On to mute the transmitter.

CAUTION

Ensure that a management connection is 
available to re-enable the remote 
transmitter after the test, or alternatively, 
use the Pause Transmitter function.
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1 If you want to temporarily mute a transmitter, set the 
Pause Transmitter field at the terminal to Enabled, 
then set the length of the pause in the Pause Tx Period 
field.

The transmitter will resume normal operation at the end 
of the period.
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Upgrading firmware in the DMR
The IDU and ODU both include two memory banks to hold 
the Codan 8800 series DMR firmware. TFTP is used to 
upgrade the Codan 8800 series DMR firmware version. Any 
TFTP server can be used for this purpose, however Codan 
recommends the following freeware program: Pumpkin from 
Klever Group, Inc. (http://www.klever.net/kin/index.html).

To upgrade the DMR:

1 Ensure that the terminal is powered up and working 
correctly.

1 At the Command Prompt, ping the IDU from the PC 
being used to perform the firmware upgrade to confirm 
network connection.

1 Ensure that a TFTP server is running on the network 
before performing the firmware upgrade.

1 Access MINet at Supervisor level (see page 18, 
Accessing MINet).

1 Connect to an active configuration (see page 85, Loading 
the active configuration).

1 In a 1+1 redundancy system, select the link that is not 
currently transmitting data.

1 If you do not want to upgrade a terminal, click the link-
end selection button for the terminal that you do not want 
to upgrade (see Figure 2 on page 21 or Figure 3 on 
page 22).

1 From the Functions menu, select Operations, then 
TFTP (S/W Download)..., or click  in the tool bar.

NOTE When firmware is upgraded, the new version is 
always placed into the alternate memory bank.

CAUTION Firmware upgrades should only be performed 
by suitably-trained personnel.
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1 Enter the IP address of the TFTP server into the Server 
IP Address field, or if the local PC is the TFTP server, 
click Set Local IP to enter the IP address of the local 
PC.

1 Enter the filename for the upgrade firmware of either the 
IDU or the ODU in the File Name field.

1 Click Apply Now.

The status of the TFTP activity is displayed in the Last 
Operation field. During a transfer, In Process is 
displayed. When the transfer is completed successfully, 
Success is displayed.

CAUTION The File Name field is case-sensitive.

NOTE
Use the ODU*.bin filename or the 
IDU*.bin filename. Only one file is 
transferred to the DMR at a time.

NOTE
An upgrade to an IDU may take from 
30 seconds to 10 minutes. An upgrade to 
an ODU may take 5 to 15 minutes.
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1 Upgrade the remaining firmware by entering the 
appropriate filename in the File Name field, then click 
Apply Now.

1 Click  in the tool bar to check that the version of the 
upgraded firmware is displayed in the Alternate S/W 
Rev field.

1 Switch over the memory banks (see page 111, Switching 
over the firmware memory banks).

1 In a 1+1 redundancy system, repeat the firmware 
upgrade process on the active link.

WARNING

Do not interrupt the upgrade process as it 
will cause irreversible damage to the link. 
Wait for Success to be displayed before 
continuing. If an error occurs, repeat the 
process until Success is displayed.

NOTE You cannot view the alternate firmware 
version of the ODU.
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Switching over the firmware memory banks
A version of the firmware for the Codan 8800 series DMR is 
stored in each of the active and alternate memory banks in 
both the IDU and the ODU. The versions stored in memory 
are typically the latest version loaded and the previous version 
loaded. Generally, bank switchover is performed after a TFTP 
firmware upgrade, or after a system irregularity when the 
backup firmware is needed.

For the IDU, the current firmware versions present in the 
active and alternate banks are displayed in the Components 
Revisions dialog (see Table 1 on page 94). For the ODU, only 
the active firmware version is displayed.

To perform bank switchover:

1 Connect to an active configuration (see page 85, Loading 
the active configuration).

1 In a 1+1 redundancy system, select the link that is not 
currently transmitting data.

1 From the Link Operations menu, select Bank 
SwitchOver.

1 Select the terminal at which you want to switch the 
memory banks first.

212.180.1.200 212.180.1.100
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1 Select the IDU and/or the ODU check boxes for the 
individual units at the terminal you have selected for 
switching.

1 Click OK to switch the memory banks.

1 In a 1+1 redundancy system, repeat the bank switchover 
process on the active link, if required.

CAUTION

Performing a bank switchover resets the 
link. The terminal that is at the greatest 
number of hops from the management PC 
must be updated first.

NOTE

The number of network hops to each 
terminal may be determined from the TTL 
count in the ping response. The terminal 
with the lowest TTL count is the furthest 
away from the management PC and must 
be updated first.
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Restricting access to the configuration of 
the 8800 series DMR

Access to your 8800 series DMR system is restricted via the 
keys on the front panel on the IDU, and at the launch of 
MINet. There are three levels of password protection provided 
for the 8800 series DMR. The factory-default passwords for 
the front panel of the IDU and MINet are shown in Table 2.

These passwords should be changed after commissioning the 
link, or if there is a risk that unauthorised personnel will 
tamper with system settings. The front panel password can 
only be changed using MINet.

If an unauthorised change to a parameter is attempted through 
MINet, the Authorisation dialog is displayed.

NOTE The front panel and MINet passwords act 
independently of each other.

Table 2: Access levels and factory-default passwords

Access level Purpose Default password 
for keys on front 
panel

Default password 
for MINet

User Provides read-only 
access. 

ESC ESC ESC 
ESC ESC 

user

Administrator Provides read/write 
access to configuration 
options. You cannot 
access options that 
may affect the 
integrity of the link.

ESC ESC 
SEL/SAVE 
SEL/SAVE 
SEL/SAVE 

admin

Supervisor Provides full 
read/write access to all 
configuration options.

ESC ESC 
" " "

super
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Changing the password for access via the keys on 
the front panel

To change the password for the front panel of the IDU:

1 Open the configuration file, or connect to the terminal 
that you want to change (see page 90, Opening an 
existing configuration from file or page 85, Loading the 
active configuration).

1 From the Functions menu, select Configuration, then 
Management..., or click  in the tool bar.

1 Select the Change Front Panel Sequence tab.

1 In the Security Level frame, select the access level for 
which you want to change the password.

1 Click New.

NOTE The password set in this dialog is applicable to 
this IDU only.
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1 Press the keys in the Front Panel Sequence frame to 
create a sequence of five key presses.

If you make a mistake at any point, click Clear.

1 Click Confirm.

1 Repeat the exact sequence of key presses.

1 Update the active configuration (see page 87, Updating 
the active configuration for an operational link).

1 If you are working off line, from the File menu, select 
Save to save the configuration file.

1 If you want to save the log file see page 92, Saving an 
alarm log file.

NOTE
Press the keys slowly. An asterisk will 
appear in the field when the key press is 
registered.
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Changing a password for access to MINet

When you change these passwords, they become applicable to 
all sessions of MINet run from the PC.

To change a password for an access level in MINet:

1 From the Options menu, select NMS Security..., or 
click  in the tool bar.

1 Select the Change Password tab.

1 Select the access level for which you want to change the 
password.

1 In the Password frame, Old field, enter the existing 
password.

1 Enter the password that you want to use in the New 
field.

1 Enter the password again in the Confirm field, then 
click OK.

You are informed of any errors made while entering the 
old password, or confirming the new password.

1 Click OK or Cancel.

NOTE The password is case-sensitive.
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Changing the current access level in MINet
You can change from one operating level in MINet to another, 
if you have the correct authorisation password.

To change to another access level in MINet:

1 From the Options menu, select NMS Security..., or 
click  in the tool bar.

1 Select the Authorisation tab.

1 Select the new access level into which you want to log.

1 Enter the password into the Password field, then click 
Apply.

1 Click OK or Cancel.

NOTE The password is case-sensitive.

NOTE

Configurations must be updated to gain 
correct access levels (see page 87, 
Updating the active configuration for an 
operational link).
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Resetting a link or an individual terminal
You can reset an entire link, or individual terminals using 
MINet. A reset shuts down and restarts the link or the 
terminal.

Resetting a link
To reset a link:

1 Connect to an active configuration (see page 85, Loading 
the active configuration).

1 In a 1+1 redundancy system, select the link that is not 
currently transmitting data.

1 From the Link Operations menu, select Reset Link.

1 Select the terminal that you want to reset first.

WARNING Resetting a link or a terminal will affect 
customer traffic.

CAUTION
The terminal that is at the greatest number 
of hops from the management PC must be 
updated first.

NOTE

The number of network hops to each 
terminal may be determined from the TTL 
count in the ping response. The terminal 
with the lowest TTL count is the furthest 
away from the management PC and must 
be updated first.



Operating MINet

MINet Management Software User Guide 119

1 Click Yes.

1 In a 1+1 redundancy system, reset the active link, if 
required.

Resetting an individual terminal
To reset an individual terminal:

1 Connect to an active configuration (see page 85, Loading 
the active configuration).

1 In a 1+1 redundancy system, select the link that is not 
currently transmitting data.

1 From the Link Operations menu, select Reset 
Terminal, then select the terminal that you want to reset.

1 Click Yes.
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Setting the factory-default configuration
A factory-default configuration is stored in the memory of the 
IDU. You can reset the active configuration to its factory-
default configuration.

This activity should only be performed after all precautionary 
measures have been taken. It is recommended that all current 
configurations are saved before implementing the factory-
default configuration to prevent the loss of complex 
configurations.

To set the link to the factory-default configuration:

1 Connect to an active configuration (see page 85, Loading 
the active configuration).

1 From the Link Operations menu, select Set Factory 
Default.

CAUTION IP addresses and link parameters will be lost.
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1 Select the terminal that you want to set to the factory-
default configuration first.

CAUTION
The terminal that is at the greatest number 
of hops from the management PC must be 
updated first.

NOTE

The number of network hops to each 
terminal may be determined from the TTL 
count in the ping response. The terminal 
with the lowest TTL count is the furthest 
away from the management PC and must 
be updated first.

CAUTION The IP address and link parameters will be 
lost.
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If technical assistance is required...
If you need to send configuration information to Codan for 
technical support, send the .cfg file and both .cfs files for the 
link.

Should you require technical assistance from Codan, please 
refer to the contact details supplied with the equipment. These 
details are also available on the internet at 
www.codan.com.au. In the Microwave Links section, click on 
Product Support.

Outside of normal office hours, Codan has Customer Service 
Engineers on call to provide emergency technical assistance. 
They will either answer your call immediately or return your 
call as soon as possible.

If you are connected to a voice mail system when you call, 
please follow the instructions carefully, that is, leave your 
name and contact phone number (including the country code), 
then a brief, clear description of your problem.
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Appendix A�Example network 
diagrams

Table 3: Example network diagrams

Title

Out-of-band management of a 1+0 network

In-band management of a 1+0 network
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Out-of-band management of a 1+0 network
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Out-of-band management of a 1+0 network
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Subnet mask 255.255.255.0

SITE 1

Use the command prompt to add the following route to the 

management station:

route add 212.180.0.0 mask 255.255.0.0 212.181.1.100
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In-band management of a 1+0 network
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